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rrozz [

HE, AVvE—URBMENDET AL R T 4 27 EIT, Tsyslog] EWHIARIOTF 4 L2 B Y

DERR S ILET,
GE) IOFTvasE, B——7 v RE—REREI RN T VAT LY N = RTE
JEATEET,

ATV TN ASA THERTAVAT AR DX a2 —H 4 A2 ELET,

FTP D& E
a7 Ny 77 ONEORGFIHEHTHFIP—"—0Da 7 4 Falb—aaRETDHIC
%, ROFIRZFATLET,

FIE

AT w71 [EnableFTPclient] F = v 7/ Ry 7 A% A N2 LT, FIPZ 74T FDOay 7 4 X2 b—g
VEA X —T I LET,

ATV T2 FTPYV—_"—DIPT7 FLAZRELET,

RTYT3 REINDIRT RNy Ty a7 Y OBMELE D FTPh—_—EDT 1 L7 N "2 %4
ELET,

ATV T4 FTP YV —n_—itu /A o9 5-bDa—P—Z&2fRELET,

ATV TS FIP V==l T 50D 2—F—LICBEM T SN AT — RERELET,

ATV T6 NAT—REfERL, [OK] 227V v LET,

AX JICERTSEI75 91 AEYDERE

T RNy 7y ODNKERNET 7 v a AFVIREFET 256 ORIRFHEEZFETET 21213, K’
DFNAZFEITLET,

FIE

ATy Tl XU JIEHTELINET 7 v v a AEY ORRKEREZEELET (KB HAL)

RATYT2 HEFFTL2NET7 7 v a AEVORBEIRELET KBHEN) , W77 v vaAEUNRD
OHIREIZESL &, FrLnmr 7B REFES 272D £7,

ATwF3 [OK] %7 U7 LT, [Configure Logging Flash Usage] ¥4 7 2 /R v 7 2% T ET,




B cxa7o0x 0080

X277 AXUT0EME

ATy T
ATy T2

ATvT3

ATvT4
ATy TH

FIE

[Configuration] > [Device Management] > [Logging] > [Syslog Server] ®EIZERIN L F 9,
EXaT X T EA R—TNWICT D syslog P—/N—ZIRL, [Edit) #7 Vv 27 LET,

[Edit Syslog Server] A 7 B V7R v 7 ANERINET,

[TCPl| A7 v ary KA %7 U w7 LET,

TF¥ a7 uX L/ TIRUDP 2 R—F LT, Zo7o baLzHLE) &35
T —NRELET,

[Enable secure syslog with SSL/TLS] = v 7 AR v 7 A% A4 LC, [OK] %27V v 7 LET,

(fEE) [Reference Identity] |, syslog t— 3= 55215 U7-REBEIC %925 RFC 6125 S/
IDF=v7aAR—TNITHBMID ATV = PEARITHELET,

ZWID AT V27 MZOWTFELLIE, 2IRID ORTEEZSH L T ZE N,

syslog H—/\—[Z3%{E 9 % EMBLEM A2 D syslog » vt — D AERK

&

ATy T2

ATvT3

ATy T4

syslog #—/3—~ EMBLEM JER D syslog A v&— %A T H121E, RO TFINEEZFETL E
—§—O

FIE

[Configuration] > [Device Management] > [Logging] > [Syslog Server] ®IEIZERN L F 97,
IPv6 Z 41 L7z syslog DEER Y AR — I TWET,

[Add] Z#7 UV » 27 LT, H L\ syslog V—"ZBMLET,
[Add Syslog Server] # A 7 1 7R v 7 ANRFRINET,

G¥) 12O0EF2 U7 4 2 TFA MK LTHETE S syslog h—3—DEITHzKT
4T9 (AFEFTI16 £7T) .

syslog V= "—NE TV —IREDHE, ASATHF 22— AND I ENTEDLA v —VHERE
LET, ERErDOEEIX, Fa—ICANLLILD Ay =B ERIRIZZR D £5,

[Allow user traffic to pass when TCP syslog server is down] = v 7 R v 7 A% 4 2 LT, syslog
Y= N=BRF T L TVDHEEICTXTO T 74 v 7 E2FFATLRXICRELET,

ASA T, TCP #fit IH7= syslog —/3—(T syslog A v —VZEET DL IICHEINT
WHEE, syslog T —_—ZEENRETDHE, X2V T A REDOT-DIZ ASA ZEHT 5

FLWERZ 7 ey 7 LET, syslog —3—=D8EL TW 7R WA THHT LW 2 75
HITIE, ZOF =y IRy 7 RAeF A LET,


asdm-718-general-config_chapter25.pdf#nameddest=unique_1027

{0> i 715~ 0> EMBLEM o 2D syslog * vt — 05 [

UDP Z45E3 5 &, ASA 1L, syslog —/S—DEH{EL TV D00 E 5 MITBEFRZe <8 LW 2k
ZIF LT E9, AR — MEX, Ebo07a Fai T 1025 ~ 65535 T, T 7+
JL h @ UDP R— hX 514 T, T 74/ h®D TCP R— ~iZ 1470 T,

GE) TCP T® syslog DE(FIE, A X /3 ASA TlEHAR—hEnTWnEHA,

fthad 1% ~D EMBLEM 2R D syslog A v — O DERK
> 7156~ EMBLEM FER D syslog A > E— U %A T HI121E, RO FIEZFATLET,

FIE

AT w71 [Configuration] > [Device Management] > [L ogging] > [L ogging Setup] % &R L £ 9,
AT 72 [Send syslogs in EMBLEM format] &= v 7 /R v 7 A% A2 LE T,

syslog Y —/\—DREDEME - (THwE
syslog — "—FREZBIETZITRET 2121E, WOFIAEEZFATLET,

FIE

RT9 T syslogh— =L OBFEIHEHT LA =T =4 A%, Fay T X UARMPLERRLE
j‘o

RATY T2 syslog br—"—LDBFIHEATHIPT RLAZAHLET,

syslog Hh—/3—7% ASA £7-1X ASASM & DEFEICMHEH T2 7 2 k= (TCP £721% UDP) %
IR L EJ, UDP 721X TCP OWT I Z A L T syslog b —"—ICT7 —F ZXETH LD
IZASA BLWNASASM 23X ETH I ENTEET, I'r FaLzBELRWGE, 77 4/V
ko>~ a k=% UDP TF,

2L TCP #fRET D &, ASAlLsyslogh—N"—DEELZHRHE LI XIC, X2V T+
FOHTASA Z#RRETHH LWERiE 7 2y 7 LET, syslog r— N—|ZfEE
MFEAE L THHE LW 2 FF Al 5121%, syslog ¥ —/3— (24595 EMBLEM /&
KD syslog A vE—TOER (143%—2) ORAT v T 4ESRLTITZSN,

AT 973 syslog —/3—1ZB T, ASA £7213 ASASM & DEEICHEA SN LR — hMESE AT LE
R

AT 74 [Log messages in Cisco EMBLEM format (UDP only)] = v 7 Ry 7 A% A4 N2 L T, ¥ A2
EMBLEM P TA vt —Y & m 70T 20 E ) hafiELEd (Fr has s LT UDP
PRI TWDHEITRD)

AT 75 [Enable secure logging using SSL/TLS (TCP only)] = v 7 R v 7 A% 412 LT, syslog % —
IN— DR SSL/TLS over TCP O FHIC & 0 {R7# S 41, syslog A v & — P DNENRE AL S

o m



. REQ S /8y T 7D syslog * v E£—CDiEE

ATvT6

NAHLEY>BELET, LEWSCTERIDIZEA L., URIRELEZZRIDA TV =7 Mok
SWCHEAEZRGIECE £9, S VWTIE, BXFaT7 exXo7oa0 (14 X—) %
BRL TSN,

[OK] %7 Vv 7 LTREZET LET,

RERO T /18y T 7AD syslog * v —DiEE

&

ATvT2

ATvT3

ATy T4

— IR IR IR & T DN 7 Xy 7 7 IZIRET 5 syslog A v B — VA FRET HLENH
DET, LAY E—IF, VA MORRBIZEMSNET, Ny 77BN o0l oiz b
X, DFEONY T T T BRRELESGE. ASARWVSIEWNI 2o TNy 7 7 B RIOGETIC AR
FTHEIICHESNTVARWVIERD | A v e—VI3AERESNDH LA v E—DI2E - T
EEXEINET,

syslog A v B—UERNH a7 RNy 7 7IZEEFTHIE,. ROFIEEZEITLET,

FIE

WRONTNINOF T a @R LT, Wi 7 Ny 7 7 ZXET 5 syslog A vE—T %R
ELET,

* [Home] > [Latest ASDM Syslog M essages] > [Configure ASDM Syslog Filters]
* [Configuration] > [Device Management] > [Logging] > [L ogging Filters]

[Monitoring] > [Logging] > [Log Buffer] > [View] DJEIZ®EIR L F7, KIZ [Log Buffer] <A > T
[File] > [Clear Internal Log Buffer] DJIEIZEIRNL T, WEHin 7 Ny 7 7 2= L ET,

[Configuration] > [Device M anagement] > [L ogging] > [Logging Setup] DJIEIZER LT, NE=
TNy T 7D AREELLET, 774NV DNy 77 A X(T4KB TT,

ASATE, HTLWA v —UEBIEmENEE 7 Ny 77 IREL, WaoldWigslza 7Ry
77 ONEENE 7T vva ARVIHRFLET, Ny 77 ONEEDNOGFTNIRGET S &
X, ASA X, ROZA LAY TR EFEHT 24801 Tn Y 774V EERLET,

LOG-YYYY-MM-DD-HHMMSS . TXT

YYYY (245, MM [ZH. DD IZH . HHMMSS 3. 4. B L O TR ENT-EEZ T,

BOGFTICH LA v =V 2 RAETDITE, ROF T a inb 1 DEBRLET,

N7 T v a AEVIZH LA vE—VU%KET HIZIE, [Flash] F=v 7Ry 7 A%
412 LT, [Configure Flash Usage] %2 Y v 7 L £73, [Configure Logging Flash Usage] %
ATalRy 7 ARERINET,

1L X o IiflT57T7 v a2 A DORKEESY KB CHRELE T,
2. aX TR T7Tvva AEVIRETAR/NEZEEESY KB THEELET,



mHas Ry 770759 1~08% I

3. [OK]Z2Z Vw2 LT, 2OFA4Tar Ry s 2% LET,

s FTP r—N—IZH LIV A v E— U % E(ET HIZIEL, [FTP Server] T = v 7Ry 7 A%
\Z L. [Configure FTP Settings] %7 Y » 7 L £7, [Configure FTP Settings] % 1 7 2 77K >
I ANERREINET,

1. [Enable FTP Client] &= v 7 R v 7 A% A N2 LET,

2. BAREINTT 4=/ RIZ, FTPH—"—IP7 FL A, NRRA a—HF—4 NIAT—F
AN LET,

3. AV FEMEBL. [0KI 227 v/ LTZOSA TR Ky 7 2 LET,

REOAYT NV T7DTSY S a~DRRE
WEa 7 Ny 7757 T v o AT VIHREFET DI, ROFIEEZFEITLET,

FIE

AT w71 [Filg >[Savelnternal Log Buffer to Flash] DJIEIZER L £ 9,
[Enter Log File Name] % A 7 1 7R v 7 ANMFRINET,

ATY T2 BUIOF T a o EER L, LOG-YYYY-MM-DD-hhmmss.txt JERDF 7 4+ /L N 77 A V4T
0y Ny 7y ERFELET,

ATYT3I2HEHDE T a v B8R, 20Ol Ny 77D 7 7 ANVALERELET,
RTYT8 a7 Ny T757D7 7 ANHEANLT[OK] %227V v 7 LET,

AT DORBTHEATIELBAT ISy 1 A E)DRENER
7 OFREKTHEM RN Y 7 v v a A ORELZEETDITE, ROFIEZFETLE
j—o

FIE

A7 w71 [Configuration] > [Device Management] > [Logging] > [Logging Setup] % &R L £,

AT 72 [Enable Logging] = v /Ry 7 A%t I LET,

AT 73 [Logging to Internal Buffer] 3% [Save Buffer to Flash] = v 7 /R v 7 A% A4 2 LE T,
AT 74 [Configure Flash Usage] &7 V v 7 L £,

[Configure Logging Flash Usage] % A 7 1 V7R » 7 ANEKRENE T,

ATvTS a /A NMERTEL 77 vva AF) DRKREREZ KB TANLET,




B AsomuavaConsole 1=k BEBENETL b DSEEDE—

T 74N RTIEL, ASAIEX, W77 v a AFYVORKIMBE 0 7 F—X Il TEET,
ASA TR VT —F ZRFT HT-OICHERRNT T 7 v a AE Y OR/NEZFEITZIMB T
7, W%7?/7:%%)’%féﬂf“ém777KWLiD\W%77//:X%U®§
ERENHRESINT-HR/NBORELZ FHRI->TLEIHE, ASAIIRbEVE 77 7 A L ZHIER
L. fiLnwe 77 7 A VORGFEE b R/AINBOFEDHERIND I LET, HIBRT 27 74
BRIV E ., FRE T 7 AL ETRTHIFRL T2 E AT ) OREDNE/NREOREE T
B> TWDEHE, ASAIXZOH LW 77 7 A VERFTEEHA,

ATYT6 77 vva AFEVICRX LTI 50 HMERT 5 28 S RO/ NS % KB TANLET,
ATw 771 [OK] %7 U 7 LT, [Configure Logging Flash Usage] ¥4 7 2 7R v 7 2% LT ET,

ASDM Java Console [C &k B itfkSnf-T o ) DSBEOE—

ATwT1
ATvT2
ATvT3
RTv74

ASDM Java 2> Y — V& LT, ASDM =T —D F T T )V a—T 4 U TITERILD, ftdk
SN P ETHRA MEXN TR RBIRa Y —TE 7,

ASDM Java Console {7 7 ¥ A4 5121k, ROFNEEZFEITLET,

FIE

[Tools] > [ASDM Java Console] DJIEIZER L £,
ayY—=ATmeEANLT, FH~ v DOAT ) HEHERZFRLET,

AV =)L TgEANLT, IR—=Y aLrvar2FETLET,

Windows # A7 ~3%— % &% &, asdm_launcherexe 7 7 A V& X727 U v 7 LT, AE
UEHEZERLET,

G¥) ATV EY B TORKREIL 256 MB TT,

BFA—IL T ELAAD syslog A v E—PMiEE

ATy I
ATy T2

ATvT3

RTv74

.

syslog A vE—U%BE A= T RLRIZEEFETHIZIE, ROFIREZFEITLET,

FIE

[Configuration] > [Device Management] > [Logging] > [E-mail Setup] %R L £,

B A A= L L TEEFEEIND syslog A vE—VDOEELT FLAE LTHERT S
BFA—NT FLAZRELET,

B (Add) 127V 7 LT, fBE Lsyslog A v =Y OZEEOHF LWVETFA—L T K
LAZ AT LET,

ZDOZAEHEIIEET Hsyslog A v E—VOEKEL~LE, Ry XA RDLERL
FT, SWEDEFA LT RLAIZH L THEHAIND syslog A v E—VOEKET 4 VX



grr—n2EsoenzEae [

D, BESNTEZERELLVLED A vE—U 015G S ET, [LoggingFilters] ~<A > T
ESINTZTm—rb 74 Z by FEFA-NAZEEHEICHEA S NLET,
RATY 75 [Edit|#7 Vv 7 LT, ZOZFEE~KEET Hsyslog A v E—VOBEOEKREZELTLET,
ATwT6 [OK] %27 V27 LT, [Add E-mail Recipient] ¥4 72 7R 7 A% L E£7,

BFA—ILZEZEDEME-IIHRE
B A—NOZEEBLOCERELZBNEZIIREST 22F, ROFIEEZFEITLET,

FIE

AT w71 [Configuration] > [Device Management] > [Logging] > [E-mail Setup] % 4R L £,
ATw 72 [Add] £/2IL[Edit] 27 U v 7 LT, [Add/Edit E-Mail Recipient] ¥ 4 7 2 7R v 7 A% FRr L F
R

RTYT3 SEDETA—NVT FLAZANL, Fuy 7 X7 )R Rinbsyslog AR Z 3R L £7,
HRELVSIVFRO LS ICERSNTVNET,

« Emergency (L~L 0, ¥ 27 ADMEHAHE)
GE) HEE L~V 0 2T 25 Z L3k TE £ A,

 Alert (L~ 1, RIREGH LS 40 22)

e Critical (L~)L2, 7 U T 1 FIVGAMF)

* Error (L~L 3, =7 —%fF)

« Warning (L~UL 4, #4552 0k)

* Notification (L/V 5, IEH 7203 70 5efF)

« Informational (L~ 6, fHH A v E—YDRH)
* Debugging (L)L 7, TNy T A vtE—UDH)

GE) BHBAA—NT RLANDA v —T% 7 4 V2 ) 735850, [Add/Edit
E-Mail Recipient] % 1 7 12 7R > 7 2 CTHE LI-EHKE & | [Logging Filters] ~A >
TTRTCOBEAFA—NZEEICH L THRE L7 a— L 7 4 L EDOEKED
H, LR ENET,

AT 74 [OK] %7V v 27 LT, [Add/Edit E-Mail Recipient] %1 7 0 7 7R v 7 A% L %7,

BNFEZIMEE SN2 kU A [E-mail Recipients] <A NZF RSN ET,

ATYTE [Applyl 227 U w7 L, BEARFZEITa L 74 Falb—va VIRTFELET,

| ns



B ov=—tswryv—n—omx

1) E— bk SMTP H—/\—DERFE

FrEDA R MIRTDETF A= 77— B LOEHMORER LD Y E— b SMTP #—
N=ZBET DI21E, ROFNAZFEITLET,

FIE

AT w71 [Configuration] > [Device Setup] > [Logging] > [SMTP] DJIEIZER L £ 5,
ATYT2 774~ SMTP H—"—=DIP 7 FLAZ AT LET,

ATwT3 (EE) AZ LA SMIPH—_"—DIPT7 FLA2Z AN L, [Apply] 227V v 7 LTEFRRNE
FFEITa T4 X2 — g VITIRIELET,

a2Y—I)LiR— bA®D syslog * v tE—CDEE

syslog A vE—V %23y —)LR— MIEET DT, ROFIEEZFEITLET,

FIE

ATV T RONTNLOFT > a v EBRLET,
* [Home] > [Latest ASDM Syslog M essages| > [Configure ASDM Syslog Filter

» [Configuration] > [Device Management] > [L ogging] > [L ogging Filters]

AT T2 [Logging Destination] 7 7 A T2 Y — /L& @&IR L, [Edi) %7 Vv 27 LET,
[Edit Logging Filters] # A 7 12 77K v 7 ANRFRSNET,

ATV T3 TRTOARU N 7 TRAEFIFRFFEDA XY b 7T ADNT DN syslog IR LT, =
V=V AR— MIZEET D syslog A v E—VERELET,

Telnet £/=1XSSH v < 3 UoAD syslog * v E—TDiEE

syslog A v —% Telnet £7213 SSH ¥ v & a3 LICEET 51213, ROFIELETLET,
FIg
ATV T RONTNNDOF T g 2R L ET,

* [Home] > [Latest ASDM Syslog M essages] > [Configure ASDM Syslog Filter s

* [Configuration] > [Device Management] > [Logging] > [L ogging Filters]

AT w 72 [Logging Destination] % 7 2 ® [Telnet and SSH Sessions] Z3#®R L, [Edit] #27 U v 7 L ¥ 7,

.



syslog * v £—C DEERTE .

[Edit Logging Filters] % A 7 12 77K v 7 ANKRSINET,

ATYTI TRTDOARU N I TAEIHEDA XU N 7T ADWT DD syslog &34~ LT,
Telnet £721X SSH & v ¥ = NNZEET D syslog A v =T & FEELET,

AT 74 [Configuration] > [Device Management] > [Logging] > [L ogging Setup] DJIEIZEIR L T, HIED
tyvarounX o SR A RX—T M LET,

AT w75 [Enablelogging] = v 7Ry 7 A%A 2L, [Applyl 227V v 7 LET,

=JL =

syslog A vt —L DEETE

syslog X v E— U DERTE
syslog A v B—UZRET HIZIE, ROFIEEZFEITLET,

FIE

AT w71 [Configuration] > [Device Management] > [L ogging] > [Syslog Setup] DIEIZER L £,

ARTVT2 7740V A=V DOR=2L LTHEMHT S syslog —"—D T RA7 A v Ve 2RI L E
T, 7 74/ MXLOCAL(#4)20 T%, Zhid, FEAEDUNIX VAT ATHELRHa— R
T, 7770, XY hT—7 TARA AT DDOT7 7 T4 NEFENTWAED, VA
TARITTIIZOEEEEL L2T IR RWEERH Y £7°,

AT v 73 [Include timestamp in syslogs] = v 7 R v 7 A% A4 N2 LT, 5 EIN D% syslog A vE—V
WZAAF ERRZI A BN L £ 9,

[Timestamp Format] K& v 7% 7 U ZFHH LT, LAY — (mm:dd: yyyy hh: mm:ss) F720%
RFC 5424 (yyyy: Dd: mmTHH: Mm: ssz) &SR L E5,

AT9 T8 v s A IR RR LIS AT B e — —4 % syslog A v & —VICERT 554513, [Hide

username if its validity cannot be determlned] Fryv IRy I AEF7IZLET, 7 77r/1/ N
Tix, 22—V =AW RIGE . ETANE S AR REGE, 2 —F—4AITHERRTT,

T2, 2=V —PRRoTa—F—L4DORDOVITRT—REANLESGE, BRELTE
REAL D syslog XA v E—U T [a—W—4 ] ZBTONLETT, e /A T L T 7L
Va—T A U TIERNETHEDIT, B Ra—F e FornT oL b TEET,

AT w75 [SyslogID] 7 — 7 /WZERT HIERZIBIR L £, AL T a3, kOEEBD T
D

* [Syslog ID] 7— 7 /LZF X TD syslog A vE—TID #FK AT 5 LI ITHRET HITIE,
[Show all syslog IDs] Z i8R L £ 9,

* [Syslog ID] 7— 7 JWIZHRIIIZT 4 B —7 /WIZ LTz syslog A v E—V ID 2 2R T-T 5
INZHRET 5 ITIE, [Show disabled syslog IDs] % 3#R L £ 9,

* [Syslog ID] 7—7 VT 7 4 /v MEDPOEE IN-EHKEZ ETe syslog A v E—T ID 72
JFEFERT DX IITHRET HI2iE. [Show syslog IDs with changed logging] % ER L £,

| ns



. syslog ID X E D#REE

* [Syslog ID] 7 — 7 /VZEKENEHL I T syslog A vE—T 1D &, BIARMIZT 4+ £—7
JNZ ST syslog A v —VIDIET 2R RT 5 L9 ITHEET 2121E, [Show syslog IDs that
are disabled or with a changed logging level] %8R L £,

AT w76 [SyslogID Setup] 7— 7 /VICIE, ZDORENRIZHESNT, syslog A vE—TV DU A FRFER
ENFET, BHETLMHEADORA Yy =T IDEITA vy E—TIDOFIAZRIRL E3, BIRL
Ayt—=VIDIE, TAE—TNMITHILE, TOERELV NV ELEEST LI L HTEET,
UARNBEED A yE— ID ZEIRT 55513, TOFMOLIICHT-2 ID 2N L,
Shift % —Z 4 L7203 b Z OFMHORKICHZHID 227 Y v 7 LET,

RT9 T syslog A v E—VICT A AIDPEEND L IRET HHA1X. [Advanced] 7 V v 7 LE
D

syslog ID E% TE D#wE
syslog A v =V OREXZET T HITIE, WOFIRZFATLET,

)

GE)  [SyslogID(s)] 7 « —/b FIZFRHEHTE, ZOHEBMICEK RS NDMHEIE, [SyslogSetup] ~<A 1T
&% [SyslogID] 7—7 VTR SN P UIZEDIRED £7°,

FIE

AT w71 [Disable Message(s)] = > 7 R v 7 A% 42 LT, [SyslogID(s)] U A MZ ID BFERENT
W5 syslog A v =% T 4 E—T7 M LET,

AT w T2 [SyslogID(s)] U A MZFEREIIND syslog A v E—V IDICEETHA v E—VOERKEORF
YLV EBRRLET, ERE L VLITRO L ICERSNTOET,

« Emergency (L~L 0, ¥ 27 AMEHAHE)
GE) HEE L~V 0 2T 5 Z L3k TE A,

« Alert (LU 1, B ALAN 24 2E)

« Critical (L~/L2, 27 U T 1 FI/VGAF)

e Error (L~UL 3, =5 —54f)

s Warning (L)L 4, #E4L44)

* Notification (L)L 5, IEH 720383 72 5:1F)
» Informational (L1 6, [HFHA v E—TDH)

« Debugging (L-UL 7, FAv S A wk—T D)




JE EMBLEM f2 X 0 syslog * v £—A~ADT/8( X ID DH S .

ATw T3 [OK] 27 V 7 LT [Edit Syslog ID Settings] ¥ 7 2 7R 7 A% L E7,

JE EMBLEM B2 X D syslog A v £—~ADT/NAL X IDDHE A
T34 A 1D % 3 EMBLEM JE D syslog A v &—IZE&D 5121, ROFINEEZFEITLET,

FIE

AT 71 [Enable syslog device ID] F= v 7 /R v 7 A% 412 LT, F EMBLEM FED syslog A vt —
VFRTWET A AIDD BEEND LI I ELET,
ATy T2 ROWTAHOFT > a VERRLC, EOLS BT/, 2D MMT 0% RELET,
* ASA DR A M4
s AfH =Tz AIPT KL R

BIRLZIPT FLAICKHIGT AA v B —T oA A4 %, Fay 77X U R RS EIR
L/iﬁ‘o

7 ALY T EMHT 5541, [In an ASA cluster, always use control’s IP address for the
selected interface] &= v 7 R v 7 A& F I LET,

« L7
FHF DA =P —ERLTIN A LET,

s ASA UV T AXL

ATvF3 [OK] %7 V27 LT, [Advanced Syslog Configuration] %A 7 1 77K v 7 A% AL £7,

syslog * vE—CICAGEEZIZED S
syslog A > E—UIZHfF SR 2B 511X, ROFIAEZFATLET,

FIE

AT w71 [Configuration] > [Device Management] > [Logging] > [Syslog Setup] DIEIZER L £ 7,
AT w 72 [Syslog ID Setup] 7% T [Include timestamp in syslogs] = v 7 R~ 7 A% A2 LET,
ATY7T3 [Applyl 227 U v 7 LTEERNRERITFELET,

syslog A v t—T DEL
FRE Lz syslog A v &=V % T 4 B—T7MZT DI, ROFIEEZETLET,

| ns



=M |
. syslog * v E—CDERKENEE

FIE

AT w71 [Configuration] > [Device Management] > [Logging] > [Syslog Setup] DIEIZER L £,
ARTYT2 T—=TNANET 48 —TNWIT 5 syslog #8R LT, [Edit) 227 U v 7 LET,
[Edit Syslog ID Settings] %4 7 2 77K v 7 ANRERINET,

AT w73 [Disable messages] = v 7Ry 7 A&EA 2L, [OK] 227V w7 LET,

syslog A v Et—CDEREDESE
syslog A v =V OEREEZZTTHITIE, WOFIRZFATLET,

FIE

A7 w71 [Configuration] > [Device Management] > [Logging] > [Syslog Setup] DIAIZER L £ 5,
AT9 T2 EREEZEFET D syslog 27 —7/VNHEIRLC, [Edit] 227V v 7 LET,

[Edit Syslog ID Settings] % A 7 2 7R v 7 ANKRINLET,

AT w73 @Y EKE% [Logging Level] Ky 7 & UARNLEBEIRL, [OK]227 U v 7 LET,

AR UNAEBD syslog A vtE—nTOvy
B A HETHE D syslog A v F — U BAER S HARVE 5 10T 5 I01E, RO FIEZFATL
7

FIE

AT w71 [Configuration] > [Device Management] > [Logging] > [Syslog Settings] DJIEIZEIN L F 7,
RT9 T2 T—TNDsyslogID &R L, [Edit) %7 Vv LET,
[Edit Syslog ID Settings] % 1A 7 2 7R v 7 ANFRINLET,

ATY T3 AZ U NAHEE Tsyslog A v —U BN ERS NN K 9129 %121E, [Disable messages on standby
umit)] F= v 7Ry 7 A A LET,

ATV T4 [OK] 227 Vw7 LT, ZOEATaT Ry 7 AZHALET,

JE EMBLEM B2 X D syslog A v £—IZTNNA X IDEEH D
T34 A 1D %I EMBLEM JER.D syslog A v E—TIZEH DI, ROFNEZFETLET,

.



nzsan1~vkyz ok [

FIE

A7 71 [Configuration] > [Device Management] > [L ogging] > [Syslog Setup] > [Advanced] > [Advanced
Syslog Configuration] DJIEIZER L £,

AT w72 [Enable syslog device ID] F= v 7 R v 7 A% AN LET,

AT w73 [Device D] i) T, [Hostname], [Interface IP Address] &7-1%[String] 47> a > RE &7V v
7 LET,

s [Interface IP Address] 47> a U ZBIRLIGE1EX, Fay XX UARNTELWA ~
H—T A APBENRINTNDZ MR LET,

s [String] 47> 3 &R L72AE1L. [User-Defined ID] 7  —/b RIZT /34 21D & A )
LET, XFFORSIE, KT 16 LFTY,

G¥) A F—TWIZF % L, EMBLEM JERD syslog A & —<°SNMP k7 v 7|27
AAIDIFERAINER A,

ATy 74 [OK] %7 V27 LT, [Advanced Syslog Configuration] A 7 1 77K v 7 A% AL £,

ARABL AR YR SDIERK

AR R VA NDOERITIE, O3 OOREMEEHEHL £,
e ARV ITTR
« R
s A vt— 1D

KrEmon X 705t (SNMP r—R_—72 8) ICEETDHEIHDAZ L AN U A NEIERT
HIZE, WOFNEEZFEITLET,

FIE

AXT7w 71 [Configuration] > [Device Management] > [Logging] > [Event Lists] DJEIZER L F 7,
ATv T2 [Add] %727V v 27 LT, [AddEventList) ¥4 7 /Ry 7 AeFrLET,

ATV T3 AXUNIVRANOARTIEATILET, AN—RIEHTEEHA,

ATFw T4 [Add] %7 VU 27 LT, [Add Class and SeverityFilter] Z 1 7 12 7R v 7 A% K LE7,

AFYyTE  Ray7lEZ o JRARNBANRC N 7T AERBIRLES, AT D240~ 7T A%,
ALTWAET A R E—RIZL-oTRRZY £,

ATYy7T6 Ry 7Zor UXERLERE LV ZBERLES, EREL-VVEROEEBY T,
« Emergency (L~L 0, ¥ 27 A0MEHIAHEE)

o m



B ocvos08e

GE) HEE LV 02T 22 L3k T EEA,

« Alert (L~ 1, BNIREGHALAS 24 BE)

e Critical (L~/L20 27 U T ¢ /VGAF)

« Error (L~L 3, =T —54)

s Warning (L~ 4, L4

* Notification (L)L 5, IEH 7203083 72 5:1F)
« Informational (L)L 6, A v E&—TDH)

* Debugging (L~L 7, T30 7 A=V DRk)

AFwF1 [OK] %7 Y w27 LT, [AddEventList) ¥4 7 /Ry 7 2% ET,
ATv T8 [Add]#7Z7 VU w7 LT, [Add Syslog Message ID Filter] ¥4 7 12 7R v 7 A% FRrLET,

ATYTY T4 NFIZEDD syslog A vE—T ID £721d syslog A »E— ID O (101001 ~ 199012
mE) BANILET,

ATFvF10 [OK]%#7 V27 LT, [AddEventList] ¥4 7 /Ry 7 ZA&%HAL £,
HEJOA Xy "R Y A MZFERESNET,

OX>T J4IL2DETE

AX T DBEAD A vtE—2 T4 )L DEH
OX T DN A =Y T AN ZEBEAT DI, ROFIEEZFETLET,

FIE

A7 71 [Configuration] > [Device Management] > [Logging] > [Logging Filters] Z &R L £,

ART9T2 74 NEEHEATHaX 7 OGmEEOLARTZRIRLET, BIRTEX20 X 705 LR &
BY T,

* ASDM

e 1/ —)L7R— b
cHwf AL

c NNy 7 7

* SNMP H#—/3—

* Syslog #—/3—




ATvT3

nxvy 74 ns0iEm |

e Telnet £721X SSH v a v~

ZDIFEN. 2FE B DI F A [Syslogs From All Event Classes] & 3 % H @ 75 7 A [Syslogs From
Specific Event Classes] C & EIREMEZITVET, 2FBHON T LTI, ¥ 7D~
DAy =% T4 NE ) T T HGEEIMMAT H2ERERA N N7 TARKRRIND
D, TRTOARU NI FZRAZH L TCRF U T 2T 4= VT HNERIRT L L
HLTEET, 3F/BHON T HITIF, BRI XU T OGmEA~DA v E—T% T 45 Y
CITT LSBT AR N 7T ARKRRINET,

[Edit] #7 VU v 7 LC, [Edit Logging Filters] ¥ 4 7 0@ /Ry 7 AR RLET, 74 /X &l
A . F23T7 4 =TT 2FIECHOWTE, m¥ 7 74 LV ZOmA (27 ~—
V) ESRLTLIIESN,

AX>T 742 0OER

ATy T

ATy T2

ATy T3

ATy T4

ATy TH

ATvT6

TANZ ZBEAT I, ROFIREZFEITLET,

FIE

HRE LIS N Tsyslog A v =Y D7 4 V2 Y > 7 %4T 5 55A 1%, [Filter on severity]
FT v a s EBBRLET,
AR b UAMIESNTsyslog A vE—V D7 4 VH Y 2T %4TH A1, [Use event list]
F T a s EERLET,
BN U750 T om0 723 _XTT 4 =7 MZT 256 1%, [Disable logging from all
event classes] 47> 3 VAEIR L FET,
[New] %27 U w27 LT, HiLWWAXU b URMEZBIMLET, 40 b URRNEFHIEM
THFIEICONWTIL, BAZ L AR URXROIER 25 =) 2ZRLTIZIN,
Fay X YA INOAR N 7 TAZBBRLET, HTELZAXU N 7T 2%
HLTWETF NS A E—FIZEoTRRY £7,
Ray7Z o JARNRDL, BX 7 Ayt —VOBERELSVEEIRLET, BERELA
JUIIRD £ B Y T,

» Emergency (LUL 0, ¥ AT A)MiEFAEE)

GE) BEEL~LLXERTAZ EIIBEIDTEEEA,

e Alert (L)L 1, RIREGHALAS 20 22)

« Critical (L~/L2, 7 U T ¢ 1/VGAF)
s Error (L~L 3, =5 —5A44)

« Warning (L~L 4, 485 544)

* Notification (L)L 5, IE% 720N BAE 72 50)




. syslog * v £—2 1D 7 1 L2 DEMFETITHRE

« Informational (LUl 6. 58 A v — D)
* Debugging (L~UL 7, T30 7 A= DR)

AT TT [Add] %227V v 7 LT, AXRVE ZTABLOEKRELLZBML, [OK]227 Y v 7 L%
ﬁAO

HATaTRy 7 ADEEIZIE, 74NV ZICKH L TCERRLZe X 705N ERINET,

syslog A v E—2ID 7 4 L2 DEMEITHRE
syslog A v E— 1D 7 4 V& AERCE T3R5 FIAIZ DUV Tidk, syslog ID 3% 7€ D e
(22 =) ZZRLTIESVY,

A= VSRAEERET 4 IILZDEME-ITwRSE
A=V DT7A4NE ) TIMMHT LA yE—Y 7 7 2B X OEKE LV A IBINE 7213
LT DT, ROFIEEZEITLET,

FIE

RTYF1 Ry T Zo s VRANNPLARY N 7T AZRRLET, HTEXZA XV~ 7T 2%, (£
HLTWETF NS A E— N> TRRD £7,

ATYT2 Fay7HZ o JRAInEH, aX 7 Avb—VOBEKREL~LEERLET, BEAELN
JVEIRD L0 TT,

« Emergency (L~ 0, ¥ 27 A0MEHIAHEE)
GE) HEE L~V 02T LITBEDTEEEA,

* Alert (L 1, HIRERHALAS 4 82)

e Critical (L~/L2, 7 U7 1 1 VERAH)

* Error (L1 3, = F—54F)

e Warning (L~L 4, E485544)

« Notification (L~L 5, TEH7EABEE R 50F)

« Informational (L~ 6, fHEHA v E—TDAH)

« Debugging (L~L 7, FNy 7 A vt —I D)

RT9T3 BRBKET LIS, [OK] 227V v 7 LET,

.



HE LI AEADY S RADTATO syslog # v —SnilE [

BELEHAZEADY SARDTRTO syslog * v E—DiEE

ATy T
ATy T2

ATvT3

7 T ANDT T Dsyslog # v —TZEE LA EITEET 51213, ROFIEZETLE
D

FIE

[Configuration] > [Device Management] > [Logging] > [Logging Filters] ##&R L £ 7,
BELEHDEOREE A —"—F 4 FT5I1001%. BRI HHNEZBIR L TS [Edit] 27
Uy 7 LET,

[Edit Logging Filters] # A 7 2 7R v 7 ANFRIINET,

[Syslogs from All Event Classes] & 721 [Syslogs from Specific Event Classes] fEIH D\ YT 417> TRk
EEELL, [OK]Z 7 Vv 7 LCZDEA Tl Ry 7 A%MLET,

72 Z2E, BERETORA yE—URHNEO 7 Ny 7 7ICEEEIND L OICHEEL, ERE3ID
haZ T ADRA =V NNER 7 Ny 7 7ICEEENL LI ETDHE, #oar 7 X
L—ya B EanEd,

1 D07 T ANEBOHEIIEICEREEND LI ETHIHAIE., WOk LI L7 41
BV T T g BERLET,

syslog * v t—DER L— FOHIE

ATy T
ATy T2

syslog A v =Y D4R L — M EHIBRT 521X, IROFIEZFEITLET,

FIE

[Configuration] > [Device Management] > [Logging] > [Rate Limit] Z 8K L £,

L— MRZEI D B THaX 7 LoyL (A yvb—VDOEKNE) Z@RLET, EELUL
FRO LI ITERSNTWVET,

 Emergency (L~ 0, ¥ A7 A0MEHARE)
« Alert (L1 BRI 4 22)

* Critical (L~L2, 7 UT 1 JVGf)

* Error (L~UL 3, =T —54F)

» Warning (L~L 4, 5 244)

« Notification (L)L 5, IEH7EABE R 5A0F)

« Informational (L~UL 6, [EHA v E— D)




B 520 syslog 2 v &— 1ot 5 L— FHIROB Y B TERES

ATvT3

ATvT4

» Debugging (L-V 7, 77307 Ay —Y0h)

EEEIND A =T DD [No of Messages] 7 4 —/V RIZFE/RSNET, £7o, BRLEB
X7 LNV TEETEDLA Yy E— /iﬁl’i’ﬁ?ﬂﬁﬁﬁ‘é ROKYUE L 72 DRI (RVEALL) 28
[Interval (Seconds)] 7 4 —/L RICERRSNET, 7T —TAnbRrF T LYLEBRIRL, [Edit]
Z 7 1 w2 L C [Edit Rate Limit for Syslog Logging Level] AT T Ry 7 AR LET,

PIBEO FINEIZ DWW TIL, 4 @D syslog A vE—12x%9 2% L— MHIBROEI Y 4 CTE =T ALHE
(30 ~—) ZZRL T EEN,

B2Dsyslog X v E—2I2xdT HL— FIRDEIY B TEELITER

syslog #

ATvT1

ATy T2

ATvT3

ATy T4

il 2 Dsyslog A vE—IIZL— MRZFI VY TH, F2EFA vE—TY T &I — MillREZE
BT 25T, WOFIEEZFATLET,

FIE

FEE D syslog A v E—I2L— MlRZEI D 4 THHE1E, [Add] %22 U » 27 LT, [AddRate
Limit for Syslog Message] ¥ 4 7 RV Ry 7 AR LET,

LIBEDFNEIZ DWW T, syslog A v E— 126 2 b— MEBROBEINE 72 13MwE B0*—)
AL T TZ3N,

FEED syslog A v EB—UIZkT 5 L— MlRZZE T 58551%, [Bdit) 2 Y » 7 LT, [Edit
Rate Limit for Syslog Message] # A 7 R Ry 7 A KR LET,

PIBEDFNRZ SN TR, syslog EAEITHT 2 L— MIIROME (31 ~—2) 2ZML TS
7230,

VE—UITxY S L— FHIBRMDEMFE - (FRESE

&

ATy T2
ATvT3
ATv74

KFE D syslog A v 2— x4 5 L— MR ZBIMEZIZEE T 5120, ROFNEEZFEITLE
7

FIE

FEED syslog A v E—UIZkd 5 L— MR ZEMT 2541%, [Add] %2V v 7 LT, [Add
Rate Limit for Syslog Message] % 4 7 2 /7R v 7 A% FRxLET, FFED syslog A vt —I1Txf
T 5L — MillRZZH 3 53541%, [Edit] #2 Y v~ LT, [Edit Rate Limit for Syslog Message]
HATOaT Ry 7 AERRLET,

L— R Z IR % syslog A v E—YDID 2 AT LET,

FBE LIZRFRNICEE CTE DA v =V ORREEATILET,

FRELIEA Yy =YD L — FEHIRT DEROENE L 22 H R RHIR A HALCA L, [OK] %
7V w7 LET,



syslog B3 5 L— riROEE [

G¥) A v —UEGIRZ LIZT 5854 1%, [Number of Messages] 7 « —/L REB L
[Time Interval] 7 4 —/V R& & HIZT T 7 DELIZLET,

syslog EXREIZxT 5 L— FHIEDIRE
$87E L7 syslog TEAMED L— MIIRE ZE T 511, KOFIAEETLET,

FIE

2Ty TN RE LI BRI CRIG TR A v 2 — VORNREIE L ET,

ATy T2 HELLERED A v E— VIS5 L— b EHIIRT 5 5 & 72 2 IR A B AT A
L. [OK] &7V v 7 LET,
AR L7z A v b — VERERFRSLET,

GE) A — U ERIRA LIZT 585451, [Number of Messages] 7 4 —/L KEB LT
[Time Interval] 7 4 —/V K& L HIZT T 7 DEFIZLET,

BAFIyoOx 05D L— MIRRDEIY ¥TEEXEE
FRHENTWAEY V—X (FTayZH A X) [ZHSNWT, aXo 7oL — MNRAEE Y XT3
TEBRTEET, LEVWE EIA) Z2HEETHILICLD, syslog A vE—TDERKL— P23
FRESNET, IHI1C, Try 7 A XOFHEN LS VEEZBX - & XITERIND A ¥
=V EERTEET,

FIE

AT 91 [%E (Configuration) ]>[7 /A AEH (Device Management) |>[2 ¥ 7 (Logging) ]>[L —
FHIFR (Rate Limit) ] ONAIZERN L E 7,

ATFY T2 [FA4FI v X 7O — MR (Rate Limits for Dynamic Logging) ] CLAF##EE L £,
«[7avZ (Block) |:#BHJL— MlREZ U H—F 5 LXVWEE L THIEET X TR v
7 DEIGEREELET,

o [AvE—UHIER (Message Limit) ]: &L — MR THAISND A v —T DL IEE
LET., 7740 MEIZ 10 TY,

ATv T3 [Applyl 227 Vv LET,
ATy T8 BRIFLMEEEFE T3, FTLWEZ AN LTEA (Apply) 1227V v 7 LET,
ARTYTS XA FIvr7uXx 7oL — MlBBEENCT DL, 74—V REEAOEFICLET,

o m



B croz=5yy

OJOE=RY2Y

RX T AT =R ADERIZONTIE, kOa~vy FEZRLTIEI,
» [Monitoring] > [Logging] > [L og Buffer] > [View]
ZORA TR, B Ny 772 RRTEET,
* [Monitoring] > [Logging] > [Real-Time Log Viewer] > [View]
ZONRAL T, VTAEALDOR T ERRTEET,
¢ [Tools] > [Command Line I nterface]

TORAUTIE, SESERFEAHTIT 4T a~r FERITL, REERTHZE
NTEFET,

O Ea—7%ZFERALEsyslog A v tE—SDT 0L V5

ATy I

ATy T2

ATv7T3

Real-Time Log Viewer 33 & O' Log Buffer Viewer OfLE DO H 7 AMIXIET 25 1 DL EOfHEIZHES
W, syslog A v =% 7 4 VF2 ) T TEET,

27 Ea—=TOWNTNnEMEH L Tsyslog A vtE—Y27 4 V&) 73 5120%, ROFIA
IATLET,

FIE

KONTNNDOAT > a v EERLET,
* [Monitoring] > [Logging] > [Real-Time Log Viewer] > [View]
* [Monitoring] > [Logging] > [L og Buffer] > [View]

[Real-Time Log Viewer] & 7213 [Log Buffer Viewer] ¥4 7 2 7 7R v 7 ADWT T, V—/b

/X—® [Build Filter] #7 U v 7 LE 7,

[Build Filter] # A 7 2 77K v 7 AT, syslog A ve—IC#HT D7 4 V2V > ML IEE

LET,

a) [Date and Time] fEIK T, U T & A A, FERZ, FEH#FHO 3 S04 7> a b 1o
ZIEIRLET, FERAEZRRL72GEE, BEZADN LT Rey 77X T U R MR
FIT @R, R ZEE LEd, R Z @R L7256, [StartTime] 7 ¢ —/L R
DRy FZI KA E 7Y v 7358, WL —RNERENET, Fay 2ol
A ML EMG B & BRI 28N L, [OK]%Z 27 Y v 27 L¥ 9, [EndTime] 7 4 —/V KD K
Oy TE U RAEZ )y I THE LU —BERENET, Fry Xy AL
MOHIETHERTRZZEIRL, [OK]Z27 U7 LET,

b) [Severity] 7 4 —/V RICHZREREEZ AT LET, F721E, [Severity] 7 1 —/ KO
TIEdit] TA 227V w7 LET, 74NE IV TTHEREEZVARNTZ Y v 7 LE
T, BEREI~T728D520F, [AlZ27 V27 LET, [OK]Z27 Vv 27 LT, b



d)

2)

h)

O Ea—7#ERALIsyslog * v E—SD T2 Y DY .

DFXTE % [Build Filter] # A 70 7R v 7 AR R LET, HHTHELOANERICET
DR I OV TR, [Severity] 7 4 —/V ROLRNIZH D [Info] TA 2 %7 U w7 L
£
[Syslog ID] 7 4 — /b RIZH#h72 syslogID # AJJ L EF, F72iL, [SyslogID] 7 4 —/L KD
FROEdit) 7T A 2w 27 )y 7 LET, RayrXZor URARNGLT 0 VERIROEKM:
ZERL, [Add| 27 Vv 7 LET, [OK] 22V 27 LT, \_ME@ % I % [Build Filter]
AT TRy 7 AR RLET, AT HIELWANERICET 2552 RICONWT
I%. [SyslogID] 7  —/\ ROAMIZEH 5 [Info] TA 2> %27 U v o7 LET,
[Source IP Address] 7 4 —/V RICHZNREEILIP 7 KL A% AT 570>, F 7213 [Source IP
Address] 7 4 —/V ROAMIT[Edit] 7TA 2> %27 ) v 7 LET, BH—DIPT7 FLAEIT
IP7 RLAORFEOHFAZIIN L, [Add]Z 27V v 7 LET, BFEDIPT KL AEZITIP
7 KL A @%ﬁé"[@%%'ﬁ‘é {21, [Do notinclude (exclude) this address or range] = v 7 7R v
JAA N LT, [OK] %27V v 7 L, [BuildFilter] ¥4 702 7Ry 7 AZZNEDRE
EFRALET, fﬁfﬁ‘?’éfl: LWANERITBE T 235/ 72 1F IOV TiE, [Source IP Address]
74—V ROEPNZH D [Infol TA %7V w7 LET,
[Source Port] 7 o« — /b RICHBREE LA — N &2 ASIT 50>, F7203 [Source Port] 7 1 —
VROLMO[Edi) 7 A 2% 27 )y 7 LET, FryF XU VR RIS T 4 V25
DEMEEBRL, [Add) 27V vy 7 LET, [OK]Z2 U > 7 LT, _ﬂgw X 7E % [Build
Filter] ¥ A4 70 7R > 7 2K RLET, HHTHIELWANERICET 53722 I
DWW T, [Source Port] 7 o —/L ROLMINZH D [Info] 7 A 2> %27V v LET,
[Destination IP Address] 7 1 —/L RIZH 72565 1P 7 KL A% AJ13 57>, F721% [Destination
IP Address] 7 4 —/V ROAMTIEdit) 7 A 2> %227 ) v 7 LET, B—DIPT KL AF /=
IXIPT7 KL ADRFEOHRIFHZZRINL, [Add] 227V v 7 LET, HEDIPT FLAE1X
IP 7 KV AD#FFHZ RSN 5 121E, [Do not include (exclude) this address or range] 7~ = » 7
Ry 7 A%eA A LET, [OK]Z27 Vv 7 LT, ZIHORE% [Build Filter] # A 7 1 7
Ry 7 A ZFoR LET, BT 2HIELWAERICEET 25572 HIC DV Tid, [Destination
IP Address] 7 4 —/V ROLHWIZH D [Info] TA 2> %7 ) v 7 LET,
[Destination Port] 7 « — /L RIZH N 72585 — b & A J19 % 0>, £ 721X [Destination Port]
T4V ROLABOD [Edit] 7 A 2% 7 V7 LET, Ray 77Xy URXARNRLT 4V
ARBOFEMERINL, [Add]Z27 V) vy 7 LET, [OK]Z2 Y v 7 LT, ZRHDOREL
[Build Filter] ¥4 7 2 7R v 7 ZAZHEKRLET, HHTLHIELWCANERICET 5587
THHIZ OV, [Destination Port] 7 4 —/V ROFENZH D [Info] T A 2> %7 Vw7 LE
D
[Description] 7 4 —/V NIZT7 4 NZ V7 THRA M2 ASILET, ZOT7FX ML, IE
HEBZEZ, 1 DU EOXFENLRIMEEDOLFINZ/ETEET, 27ZL, EIan
VEAEN R LFTIEH D FHA, o, ZORETIERIFLE/NCFEREFISNET, &
Box N ERETLHEE. 1~ TREIY £,
[OK]Z27 Vw7 LT, 8ELT T4 NVEZ Y U IREEZR YV E2—T O [FilterBy] K v~
Zor A MUBMLET, 7402 XFFNIREDTERITHENET, FILTER: 7' L7 1 ¥
7 A%, [Filter By] Fry 7 X7 URAMIERREINDTXTOHARAZ L T 4V EERL
FT, ZOT 4NV RICET VA LRTIFANEANT AL TEET,

ROFIZ, HH SN DR 2R L £7,




B - vsuvosroms

Build Filter M5! 742 XFHRK
Source IP =192.168.1.1 £7-1% 0.0.0.0 FILTER: srcIP=192.168.1.1,0.0.0.0;srcPort=67;

Source Port = 67

Severity = Informational FILTER: sev=6;dstIP=1.1.1.1-1.1.1.10;
Destination IP=1.1.1.1 ~ 1.1.1.10

725001 ~ 725003 DOEiFAS D syslog ID FILTER: sysID=!725001-725003;

Source IP=1.1.1.1 FILTER: srcIP=1.1.1.1;descr=Built outbound

Description = Built outbound

ATw 74 [FilterBy] R vy 7 H U URANDHEED | DEERL, Y —L 3—O [Filter] 7 Y v 7 L
T, osyslog A=V T4 NHZY 7 LET, ZOREIT, ZHLEOTXTO syslog A >
TV bEAENET, TR_RTOT 4N Z %27 Y T$5ITIE, Y —A"—I2dH 5 [Show All]
27y LET,

GE) [Build Filter] # A 7 0 7R v 7 ZAZER L THRIE L7 4 VAIIRFTE 8 A,
INHDT7 4 NVEIT, EDT 4 VEDMER IV ASDM By ¥ a OHRTHHT
7

T4ILE) VTR EDRSE

[Build Filter] # A 7 2 7R w7 ZZAEH U THERR LT 7 4 VB2 U o FRRGEZRET D121, K
DFNAEFATLET,

FIE

WRONWTNINDOA T a 2R L E7,
e [Filter By] Fry 7 Xy JARNTEELZANLT, 74 NVFHEHZEELET,

e [FilterBy] K2 v 7% % U 2 N T7 ¢ /L% %% L. [BuildFilter] %7 Y » 7 LT [Build
Filter]| ¥ A 70 7R v 7 A% £~k LET, [ClearFilter] %7 UV v 7 LT, BIEDO 7 4 V2 F&
EZHIBRL, FrLWVMEZ AN LET, ZRESNO5EEIT, BRI EEZZE R L T[OK]
Vv LET,

G¥) N7 4 NHE Y o TEEIL, [BuildFilter] ¥4 70 7Ry 7 ATEFR SN
77 A NBE DM ENET,




oy Ea—7EEALEEENaYY FoiiT [

« V=N NR—=D [Show Alll 7 UV v 7 35&, T4 NF2 ) 73MEIEL, TXTO syslog
AyE—UREFRINET,

O Ea—7#FERALEEEDOTY FOHET

ATy T

ATy T2

ATvT3

ATy T4

Wihonr 7 va—7 2 #EH LT, ping, traceroute, whois, ¥ X U'dnslookup =~ K%
FITTEET,

INbDaA~Y ROWTNPZFTT D121, ROFNEELFATLET,

FIE

IKONTNNOAT > a v EERLET,
* [Monitoring] > [Logging] > [Real-Time Log Viewer] > [View]
» [Monitoring] > [Logging] > [L og Buffer] > [View]

[Real-Time Log Viewer] & 7= 1% [Log Buffer] X1 > 226 [Tools] #27 U v 7 L, F{T9T5Ha~v
REBIRLET, 7003, BRINTEHEDsyslog A ve—TV %7 Vv 7 LTarys7xA b
Ama—%FRL, BETToavr Fe@RLET,

[Entering command] % 1 7 2 7R v 7 AMFBRIFL, BN LIza~vy RBAHNIZ Fa v 7¥
vy UAMIERINET,

BER L7z syslog A v 2=V DOFEETLIP T KLU AT IP T R L ADWT % [Address]
T4 =V RIZATIL, [Go]%ZZ7 Vv 7 LET,

BELEERICa~y FRARERSNET,

[Clear] #7 U v 27 LTHZHIBRL, 7T 58l0a~>y FE Ry X070 JRRnbiE
WLET, BWECLNLTAT v 73 &2BURLET, 58T LIS [Close] 27V v 7 LET,
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Logging

7.0(1)

SFEIERHNEERALTASA Ry hU—7 oo JEREEMLE
T, O 77 ANEFRRLTRET LA v arbEaEnTunET,

WOMEHAE AN X4E LT, [Configuration] > [Device Management] > [Logging]
> [Logging Setup],

L— lBR

7.0(4)

syslog A v E—UNEREND L— FEHIRL ET,

WOBEEMNEE SuE L7z, [Configuration]>[Device Management] > [Logging]
> [Rate Limit],

a¥xXo 7 JA L

7.2(1)

SFEIFEREE (BF LT L ARV NITTA BIORAyE—Y
ID) TAyE®—VAEETIDIMoa~y RCHEHAIN X7 U
A N EAER L £7,

ROMEEHAAEE Z4E L7z, [Configuration] > [Device Management] > [Logging]
> [Event Lists],

X7 ax s

8.0(2)

UE— b mX 7 RA M~OHHIT SSL/TLS /172 L 5 ITfEL £
T, ZOF T a i, BRENTZT 0 k3R TCP ORI AT
j‘o

WOMEHAEE X41E L7z, [Configuration] > [Device Management] > [Logging]
> [Syslog Server],

aXo s 77 R

8.0(4).

8.1(1)

BX T Ay—TDipaa A N2 b 7T RIHKT LY AR— R BEMESE
L7z,

WOMEHAAEE X41E L7z, [Configuration] > [Device Management] > [Logging]
> [Logging Filters],

nX T T ALRAFES

nNi-a¥o T RNy Ty

8.2(1)

BX T Ave—UDdap AN 7 TRIHTEHYAR— FREBISNE
L7z,

BRESNZuX 7 Ny 77 (ASDM., WNE, FTP, BX W77 v i) %
7 V7T HEBMYHR— kK,

WOBEHAAEE X4E L7, [Configuration] > [Device Management] > [Logging]
> [Logging Setup],

INAT — RO Ak

8.3(1)

INAT — RO ALK T 5 ARN— F2sBMshE Lz,

.



nxvsoBE ||

3
3
R

BE

TSy bk
T4 —L)
y—2

nn
]

a7 Ea—7

8.3(1)

FEETLIPT RLABLUSELEIP 7T RLAapnag s Ea—T7I28mEnE L
776

ViR X 7 L ki T
=974

8.3(2)

TCP Z{EHT % &L 9 ITsyslogh—/"—%FXET D & syslogh—/N— %Al H
TERWEGA, ASA TV — =2 UOMEHAIEEIZ 72 5 £ T syslog A v tE—
CEARTAIHLWERE T a7 LET (& xE, VPN, 77 AT
VA= By FAN— TRk ) . ZOKREIL. ASADuF s
Fa—DBNo VD EXICHH LWEERE T 0y 7375 K9 IIESE
L7z, BfEIE, nX 7 Fa—nN2 ) 78hs EHASNET,

Z OEREIL. Common Criteria EAL4+ ~DYEHLO 7= DI BMENE L=, &
FITRWRY | syslog A v B — V& EZ[E TERWGE TUEM LTI 5
T HEHMERE L 9, BEA TR T 5ICi, [Configuration] > [Device
Management] > [Logging] > [Syslog Servers] <4 >~ C [Allow user traffic to pass
when TCP syslog server is down] = v 7 iR v 7 R &4 2 LET,

414005, 414006, 414007, 414008 D4 syslog A v — U NEAINE LTz,
W S 7= ASDM EiE 1XH 0 FH A,

syslog A v E—T D7 4
NZY gL y—h

8.4(1)

WOYR—FvBEMsShE L,

s SEIERNT LHIET HDHEEOT F A S LFFNHEES < syslog A >
= T4 NE YT,

c WAL T A E DR,
A=V OHTLTED Y — b, FEMIZOWTIE, [ASDM WA
AR ZZRLTIZIN,
ZOBREIL, TR TDOASAN—V a V EHEERERH Y £,
ROBHEALE S E LTz,
[Monitoring] > [Logging] > [Real-Time Log Viewer] > [View],
[Monitoring] > [Logging] > [Log Buffer Viewer] > [View],

7T AL

9.0(1)

ASA 5580 B L TN5585-X D7 T AK Y JEEETO syslog A vt — UK
DY R—EBEMENE LT,

WO 3T I4LE L7, [Configuration] > [Logging] > [Syslog Setup] >
[Advanced] > [Advanced Syslog Configuration],




. A¥ I DBEE

HRER TIv bk &R
T+ —L1)
1J—2R
A B SAHEE D syslog |9-4(1) T VA= R— a7 4 X2 b= a VDAY A EEE THREE D syslog
A= A=V DERET 0y 7T 52DV R — M EBEMLUE LT,
WOMBEHAAEE X4E LT, [Configuration] > [Device Management] > [Logging]
> [Syslog Setup],
syslog —/"—DEF =2 9.6(2) TLS 7 7 A 7> MLELX, RFC6125 D7 a v 6 ICEHESND I ——

T IR DT O DR ID

ID DREFEL—/V AR — 325K £ L7z, IDMEEZ, syslog ¥ —
= B ==~ TLS Bt O PKI MERFIZFEITINE T, RS/ ID
DRESNTZY 77 L AID E—HLRWGE, Bia L T EEA,

WDR—UNEFINE LT, [ASDM Configuration] > [Remote Access VPN]
>[Advanced] 33 & U} [Configuration] > [Device Management] > [Logging] > [Syslog
Servers -> Add or Edit]

syslog ¥—/3—"T® IPv6
7 RLADHR— b

9.7(1)

TCP & UDP #%H1 T syslog Zitdk, £5. ZET H72DIT, syslog h—r3—
ZIPv6 7 FLATRETE DL HITRY LT,

WOBEHERAZLTE SLE L7, [Configuration] > [Device M anagement] >
[Logging] > [Syslog Servers] > [Add Syslog Server]

syslog D/V—"T/Ny 7 A
VHE—=T oA AYR— |

9.18(2)

N—T Ny LB —T A ZA%BMLT, syslog ZEfITE5LH1T7%
DEL,

HH/AERE Shiza~ > K :interface loopback, logging host
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. BERBRIBEFAT. ZEBRICTZ Y 77— DHD. UV IEOR-IHBEI/LTEThTWNS
BEFHDEITEEZCTELIEZD, HBLETHLEZNMREBDFTIDT, IEXLBABICDL
TIKETAIPMDRF AV M ESELESZL,



